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1. Introduction

In this guide we propose, as an example, the design of a simple supervision application Modbus RTU protocol
based; this example is a little step towards the design of more complex SCADA applications, but it can be useful for
anybody who approaches for the first time to a SCADA, and in particular to Winlog Pro software, to quickly
understand how to communicate with external devices.

Every time you design a new application, it is necessary to know, for each external device, the communication
protocol, the address and the list of variables that you want read or write.

In our example we have to communicate with two devices (Test Device#1 e Test Device#2) whose address are 1
and 2; for each device we want to read 3 numeric variables (Temp, Sp ¢ Out) and 1 digital variable (Alarm).
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2. Creating the project

To create a new supervision project, it is necessary to use Project Manager, the Winlog Pro integrated
development environment that provides different tools (Gate Builder, Template Builder, Code Builder).

Run Project Manager selecting own icon from Start menu.

Select New from Project menu and insert the project name (for example Test).

-loix]

File Edit Wiew Project Tools Help

= Ceramics Kiln - Forna per ceramiche [Demao)
% Spinning maching - Impianta di Filatura [Demao)

New Project x|

Mame
ITesﬂ

Ok I Cancel

Project creation

In this way you create a tree structure with all supervision project elements.
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3. Communication channel configuration
From elements in Configuration folder select Channels.

Define the logic channel 1 to communicate in Modbus RTU.

eTEY
File Edit “iew Project Tools Help
B-B3BBE- O v 0z
& Ceramics Kiln - Fomo per ceramiche [Demo) Options Chantiels Devices
= Spinning machine - Impianta di Filatura [Derma) Access Groups Template
> Test
i3] Configuratian
] Gates
Do %
7] Recipes
{1 Reports =]
& Template |1 = Channel Cloge | Help |
] Images
Configuratiory
[hamne] j Options... |
Mitsubizhi FR-CUO03 -
Idec lzumi FA
Modbus RTU TCP
M atzushita MEWTOCOL-COM
Digitek. MicroFID-10
ModBuz ASCI
SALA - PaOD =
Protocol selection
Press button Options. .. and select the serial port to assign to the channel (for example COM1). It is necessary to

set serial port specifying Baud rate, Parity, Stop bits,Data bits, Time out e Query Pause (for
these parameters refer to manufacturer data device, an example is provided in the figure)

ICDM1 vI Part

lm BaudF ate

lm Parity oK |
lﬁ StopBits Cahcel |
m DataBits

I'IUUU— Timeout [mSec.]

100 Query Pause [mSec.]

Protocol configuration
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4. Devices declaration
From elements in Configuration folder select Devices.

Insert Test Device#l and Test Device#2, respectively at address 1 and 2 on logic channel 1 previously set

il
File Edit View Project Tools Help
[E' BI3BABF- G v LU
& Ceramics Kiln - Fomo per ceramiche [Dema)] || ] Options Chariels Devices
B Spinning machine - Impianta di Filatura (Dema) .t’-‘«ccess Groups Template
B Test
423 Configuration
X Test - Devices x|
Channel Device Description
1 1 Test Devicef
1 2 Test Devicef
Add..
Modify Device

todify...
|'| j Channel |2 j Device
Description Remave |

ITest Device#s

le Cancel

ok Cancel Help

Devices declaration

Getting started - Creating a simple Modbus protocol application



5. Creating variables database

Now we can insert the devices variables in gates database

In this example we only consider numeric and digital variables (gates).

Numeric gates include all those variables that refer to an analog quantity (for example measured variables, set-
points, alarm threshold ..) and can be expressed by a byte, a word, a double word, an integer or by a floating-point
variable.

Digital gates include all those variables that refer to digital status (for example an alarm conditions, a configuration
option, ...) and can be expressed by a single bit.

Sometimes more digital conditions can be gathered in a single numeric variable, but this case will not be explained
in this example.

To edit the variables database, you need to run Gate Builder

From Project Manager, select Gates folder and double-click on each of icons (Numeric,

¥ Project Manager

File Edit View Project Tools Help

B -BABBE- |G| v ¥ Loy

B Ceramics Kiln - Forno per ceramiche (Dema) || E] Numeric
% Spinning machine - Impianta di Filatura [Dema) String

S Test

(7] Canfiguration

Digital,...).

=10l

Digital Compound

Eventdalarm

¥ Gate Builder - test

File Edit Help

-0 v | & B @A s 7

=10l x|

K1

|Numerica| gates

|

Variables database creation

Suppose you need to read the following variables (to adapt this example to a real case it is enough to modify the
gates details below).

Name Channel | Device Modbus address* | Variable type | Gate type Unit | Description

TEMP 1 1 (3:) 005 Signed Word | Numeric °C Temperature - Measure
SP 1 1 (3:) 010 Signed Word | Numeric °C Temperature - Setpoint
ouT 1 1 3:) 015 Unsigned Word | Numeric % Control Output - Value
ALARM |1 1 (1:)012 Bit Digitale Internal alarm status
TEMP 1 2 (3:) 005 Signed Word | Numeric °C Temperature - Measure
SP 1 2 (3:)010 Signed Word | Numeric °C Temperature - Setpoint
ouT 1 2 3:) 015 Unsigned Word | Numeric % Control Output - Value
ALARM |1 2 (1:)012 Bit Digital Internal alarm status

* The number between brackets represents Modbus function used to read the variable (refer to protocol manual in Project Manager Help).
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5.1 Numeric variables configuration

Repeat numeric gates configuration for both devices, having care to change device number (Device) and N ID.

Numeric variable TEMP configuration

Mumerical gates

General | Sampling | YWalue | Tolerance |

ITemp j Gate 1D ¥ Record on DB
[~ ‘Writing enahled

|1 j NID

Cescripgtion

ITemperature - P - Measured value - Test Device#]

ACCESS groups

(0]3 Cancel Help

TEMP numeric variable configuration — General folder

Mumerical gates

General Sampling |Value | Tulerancel

Iﬁ Channel I j Read block
Iﬁ Device I j White block
[3:008 =] Address

Im Sample

|1— Sample freq. [Sec)]

(0]3 I Cancel Help

TEMP numeric variable configuration — Sampling folder
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Mumerical gates

Generall Sampling value |TOIeranc:e|

—Conwversion factot
Min. walue

heasured val. 1

Engineering val. 1
Star value

tMeasured val. &

B
I Maxvelue
S
e

Decimal digits

LIl

Engineering val. 2
c | hieasure

“ariakle type

]

k. Cancel Help

TEMP numeric variable configuration — Value folder

Numeric variable SP configuration

MNumerical gates

General | Sampling | YWalue | Tolerance |

ISP j Gate D v Record on DB
¥ “Witing enshled

I] j MNID

Description

|Temperature - 5P- Setpointwvalue - Test Device#l

ACCESS groups

|| Choose. . |

(8] 3 I Cancel Help

SP numeric variable configuration — General folder

Mumerical gates

General Sampling |Value | Tulerancel

Iﬁ Channel I j Read block
Iﬁ Device || j Write block
[z:010 =] Address

Im Sample

|1— Sample freq. [Sec)]

(0]3 I Cancel Help

SP numeric variable configuration — Sampling folder
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Mumerical gates

Generall Sampling value |TOIeranc:e|

—Conwversion factot
Min. walue

heasured val. 1

Engineering val. 1
Star value

tMeasured val. &

B
I Maxvelue
S
e

Decimal digits

LIl

Engineering val. 2
c | hieasure

“ariakle type

]

k. Cancel Help

SP numeric variable configuration — Value folder

Numeric variable OUT configuration

Mumerical gates

General | Sampling | YWalue | Tolerance |

IOut j Gate ID ¥ Record on DB
[~ ‘Writing enahled

fi <] N

Cescripgtion

ICDntruI Cutput - OF -Yalue - Test Device#1

ACCESS groups

|| Choosge.. |

(0]3 I Cancel Help

OUT numeric variable configuration — General folder
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Mumerical gates

General Sampling |Value | Tulerancel

|1 'I Channel I j Read block
|1 vI Device || j Write block
|33D15 j Address

|1 Sample freq. [Sec]

(0]3 I Cancel Help

OUT numeric variable configuration —Sampling folder

MNumerical gates

Generall Sampling Yalue |TOIerance|

—Conwversion factor
kdin, walue

Measured wval. 1

Engineeting wval. 1
Startwalue

Measured val. 2
Cecimal digits

—
O
—
—

Ll

- Engineering val. 2
¥ - Measure

IU_WORD 'l “ariable type

:

k Cancel Help

OUT numeric variable configuration — Value folder

End result
After you have defined all numeric variables, you should see the Gate Builder main page similar to the one shown
below.
_ioix]
File Edit Help
= - W v | 4 ® | 3
h. D ey i
1 1 -
2 1 1 Sp 1 3010 Temperature - SP- Setpoint value - Test Devicelil  °C S_wWORD
3 1 1 Clut 1 305 Control Qutput - OF - %alue - Test Devicef E4 U_W0ORD
4 1 2 Temp 2 2005 Temperature - P - Measured walue - Test Devicelt2 *C S_wWORD
) 1 2 Sp 2 ZM0  Temperature - SP- Setpoint value - Test Devicelt2  C S_wWORD
B 1 2 Ot 2 305 Control Qutput - OP - Yalue - Test Device2 E4 U_WORD
K1 i
|N urmerical gates v

Numeric variable database
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5.2 Digital variables configuration

Repeat numeric gates configuration for both devices, having care to change device number (Device) and N ID.

Digital gates

General |Samp|ing | Walue |

|Alarm j Gate |D v Record on DB
[~ “Whiting enshled

f1 = niD

Description

IInternaI Alarm Status - Test Device #1

ACCESS groups

I Choose... |

T Cancel Help

ALARM digital variable configuration — General folder

Digital gates

General Samp|i”E1|Value |

Iﬁ Channel I j Fead block
Iﬁ Device | j YWrite block
[1:012 | address

Im Sample

|1— Sample freg. [Sec]

T Cancel Help

ALARM digital variable configuration — Sampling folder

Final result

After you have defined all numeric variables, you should see the Gate Builder main page similar to the one shown

below.

JRI=IEY
File Edit Help

= - d v | 4 5=} | % *i

Chaninel | Device | Gate 1D M 1D | Address | Descriptian | =

1 1 1 Alarm 1 1:012  Internal Alam Status - Test Deviee #1 |
2 1 2 Alarm 2 1:012  Internal Alamn Status - Test Device #2

4 3
|Digital gates 4

Digital variables database
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5.3 Alarms gates configuration

So we have created numeric and digital gates database; now we will create as example an event/alarm gate for each
device.

These gates are not read from devices but are software generated and their status wil be displayed in runtime as
"event and alarm status" and "event and alarm history”.

Let's create alarm gates with the following conditions.

Name Condition Filter time Message Registration
ion!
Internal_Alarm,1 | Alarm,1 =1 10s Atteptlon. Internal Alarm Test yes
— Device#1
ion!
Internal_Alarm,2 | Alarm,2 =1 10s Atteptlon. Internal Alarm Test yes
— Device#2

Configuration of alarm gate Internal_Alarm

Event gates

General |Cunditi0n| Messagel Class |

IInternaI_AIarm j Gate ID v s Alarm
" Meed Acknoledge

I1 j NID v Fecord on DB

ACCESS graug

!
Choose.. |

Ok [ Cancel | Help

Internal_Alarm ALARM gate configuration — General folder

Event gates

General Condition |Message| Class |

—Condition gate I J
= | Condition
DIG Type |'| Yalue
falarm Gate ID [10 Filter ime [Sec]

|1 MNID
Choose... |

Ok CCancel | Help

Internal_Alarm ALARM gate configuration — Condition folder
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Event gates

Generall Condition Message |Class |

Message

IAtte ntion! - Internal Alarm Test Deviced#l

Type Gate ID MNID
[tern 1 Choose... |
[tern 2 Choose... |
[tern 3 Choose... |
[tern 4 Choose...
[tern 5 Choose...
[tem B Choose... |
ltem 7 Choose...
[termn 8 m

Ok CCancel | Help

Internal_Alarm ALARM gate configuration —Message folder

Final result

After you have defined all numeric variables, you should see the Gate Builder main page similar to the one shown

below.

i x

Gate |0 [NID| Messane | Tvpe|Gate 1D M 1D | Condition | value | Filter time [Sec.]| Class 1| Class 2|1s Alam | Meed A1

File Edit Help

E-EH v | ¥ B B w2 E
1 Internal Alarm 1 Attention! - Internal Alarm Test Device#tl DIG  Alarm
2 im At - [nternal Alarm Test J|G Alarm
< |

b

1

1 1 10 T F

|E went gates

Alarm gates database
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6. Creating a template

Now supervision network has been set; we have defined the logical channel and its link to PC COM port and we
have connected it to Modbus RTU protocol; we have linked to this channel two devices (Test Device#1 e Test
Device#2); for both we have declared sampling variables and alarm/event internal variables.

Now it is the moment to build a template for the application.

Select Template folder and create a new template, selecting the item New>File from Edit menu. Rename the
just created template using the name Main, do this selecting it and then using Rename item from Edit menu.

-1l

File Edit “iew Project Tools Help

[E BR3®BEH- |G| v s 0wy

=y Ceramics Kiln - Formo per ceramiche [Dema) . =] Mo Name
3 Spinning machine - Impianto di Filatura [Dema)

ey =
i1 Configuratian Renam=iRS =

] Gates Name

{1 Code .

7] Recipes IMam

{1 Reports
43 Template 0k I Cancel
] Images

Template creating

Double-clicking on created template, Template Builder start in order to build the graphic page.

6.1 Declaring template variables

First it is necessary to declare which variables we will use in the template; in this example we will use all of them.

Click on button J alongside of the Gates item in the Property Editor (Property Editor is the window on the left
side of the screen that allows to modify template elements properties).

A new windows will appear; press Add gate button, select the first numeric gate and press Ok. Repeat this
operation for each numeric, digital and alarm gate that belongs to the application.
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Z Template Builder - Test o | ] 4
File Edit Help
O = @ Standad | Advanced I
bRB (L (Ao imE@dEBd o @Ho® 0
L0l =T
Tenplt il x|
Froperty I Walue Gate Type Mame Id
Name Main 0 NUM  Temp 1 +| +|
Aocess group 0 12 HHH gp :II
!
Left o 3 NUM  Temp 2 m
Top 1] 4 rLIK Sp 2
: 5 NUM Out 7 Delete gate
width 450 E E¥M  Intemal Alam 1 :
Height 308 7 EWN Internal_Alarm 2 EditGate |
BkCalor 192192192 Otimizza
Gates W . nternal_Alarm,2 J
Open function
Cloze function Ok |
Hidd Fal
i -ipixi
Style Standard
Type Channel Device
EveriAlam [a =] Ja ] _Popew |
Mame | 1D | Dezcription
Internal_Alarmn 1 Attention! - Internal Alarm Test Devicet]
Internal_alam 2 Attention! - Internal Alarm Test Devicett2
OF. Cancel

Template variables declaration

6.2 Inserting a Label object

Firstly build a Frame that will contain all the elements that will be inserted later.

To do this, select Frame object among the ones on the upper bar ( D , it is the first on the left) and click on the

template, a void rectangle will be displayed.

The next step is to insert into the created frame a static label that is a static text; select Label object among the ones

on the upper bar ( A ), then click into the frame. To modify the text displayed into the object, use Property Editor,
click alongside of the property Label and digit TEMPERATURE.

Alongside of just inserted label, position another one to visualise temperature read form the device.

To link the Label to the numeric variable TEMP, click on the button J alongside of the item Gate in Property

Editor and select NUM, Temp, 1 among the available gates.

Modify in addition the property Label inserting $5.01f °C.

Every described object can be formatted and placed as you like using Property Editor.
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_iBix

File Edit Help

0= @ Standad I.-’-‘«dvancedl

PRB( ([T ADiwEddEd o 2=
—oix R B
lgbel ]

Froperty | Yalue

ID 0

Left 105 TEMPERATURE

Top 10

*afidth 56

Height 23

Description

Bk Color 252,209,199

Curzor [default]

T=Colar

Forik "M3 Sans Serf,9,0000

Gate MUM,Temp.1

Label Z50F T

Harizontal align Center

Yertical align Center

Frame Embozzed

O Click

Or Double Click,

Label object inserting

6.3 Inserting an Edit object
Insert another Label, positioning it below TEMPERATURE and modify the text in SETPOINT

A control will be inserted that will allow to modify the value of the SP gate and to send it to the device.

Select Edit ) object from tool bar; and, as done before, link it to NUM, Sp, 1 gate using the Property Editor.

—iBix
File Edit Help

0= @ Standad |.f5.dvanced|

*RB L (T Amiw@WdEmd e @08
RER R
Eat

Froperty | Walue

ID 0

Left 105 TEMPERATURE  |%5.01f T

Top al SETPOINT !ﬁ'_:

*Width 55 = =

Height 21

Description

BkCalar 255,255,255

Cursor [default)

Forik "MS Sans Senf".3.0000

Gate HNUM.Sp.1

Meed apply Ho

Yalidation string

Style Left

Tab num a

Edit object inserting
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6.4 Inserting a Gauge object

Insert another Label, positioning it below SETPOINT and modify the text in OUTPUT.

Insert now a Gauge object ( ) alongside of the previous Label; link it to NUM, Out, 1 gate using the Property
Editor.

In this way the value of the device output power will be displayed in bar format.

Z Template Builder - Test -0 x|

File Edit Help
[ =& B Standard |Advanced|

$RB L[ A@iwEdEE o gEe B

100 | AT < - I0]x
Gauge

Froperty | Value

D i

Left 70 TEMPERATURE %5 0f T
Top i SETPOINT [Edi
Width

35
Height 20 OUTPUT 0%
Dezcription
Bk Calor 255,255,255
Cursor [default)
Calar
Fant "M5 Sans Serif.9,0000
Gate | |
Mirirnurn +alue ]
b asirurm v alue 100
Label
Style
Segments 1

Space between segmen 0

Direction Horizontal

Frame Plain

Gauge object inserting

6.5 Inserting a Led object

Insert another Label, positioning it below OUTPUT and modify the text in INTERNAL ALARM.

Insert now a Led ( @ ).alongside of the previous Label. To "give animation" to the object it is necessary to specify
which is the condition that make it change colour; modify Led ON conditions property linking led activation
condition to Internal_Alarm,1 (Internal Alarm,1l == true) alarm activation. A red led will be shown in
presence of the alarm, otherwise led will be green.
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Z Template Builder - Test - 10| x|

File Edit Help
O =& & Standard |Advanced|

BB L (T A@E Y wEHEHEEd o BEHOE

L0l AT
Led |

Froperty | Value

D i

Left 145 TEMPERATURE %5 olf T
Top 100 SETPOINT [Ear
Width

17
Height 17 OUTRUT 0%
lsieiolion INTERNAL ALARM
BkCalor 132,192,192
Cursor [default)
Aspetto stato OFF 11
Aspeto st ON 01 =10l x|
Backaround colar 0128128 I Condtion I

Led OM conditions

J VEVN Intermal Alarm. 16,1 Add

Delete |
Edit |

Cancel |

Led object inserting

6.6 Completing template

All variables read from device 1 are now displayed; to display also device 2 variables it is enough to select the
Frame we have created, copy and paste it in the template. Be careful to not paste it in the source frame; to avoid this
mistake click in a free object area of the template before pasting it. Now we have only to modify variables links in
Label, Edit, Gauge and Led objects to obtain a supervision interface for the Test Device #2.

Z Template Builder - Test -0 x|

Filz Edit Help
O = @ Standard |Advanced|

rRBE LN (T A aEdEmg e @do s

R T
Led
Froperty [ Value TEST DEVICE #1 TEST DEVICE #2
ID 0
Left 145 TEMPERATURE |%5.01F°C TEMPERATURE |%s 0 'C
Top L SETROINT [Edi SETROINT [Edi
Width 17
Height 17 oUTRUT 0% oUTRUT 0%
Desaiipion INTERNAL ALARM INTERNAL ALARM ¥
BkColor 192,192,192
Cursor [default)
Aszpetto stato OFF 11
Azpetto stato OM m
Background color 0128128
Led OM conditions MEWM Internal_Alarm,2

Two devices supervision template

To complete the template, insert now a BkBitmap object (background bitmap, @ ) previously created using any
graphic design software (for example Painf) and saved in project Bitmaps folder.
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Background bitmap inserting
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7. Winlog Pro code example

Now create the code function that allows showing the template at runtime startup.

In Code folder create a file and rename it Ma in; opening it, Code Builder starts.

& Projeck Manager

File Edit Miew Project Tools Help

=10l x|

& Ceramics Kiln - Forno per ceram Mo Mame

= Spinning machine - Impianto dil

S Test

[ Configuration

] Gatez

x
M ame
(] Template IMair‘
o7 Images
Ok I Cancel

1] i ©

Creazione di un file di codice

Code Builder is the Winlog Pro programming environment; we will use it only to define a function that will open

the main template at the application startup.

Copy and paste the following code:

// Function called at Winlog startup

Function void Main ()
#Startup

//*k*k*k~k~k*k*k*k*k~k~k~k***************************

// Open default page

//***************************************

TPageOpen ("Main") ;

end

To check syntax of the code use function Check syntax ( ).
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J¢ Files Edit Search Compile ‘Wwindow Help

=101 x|
=&

DB o ' ERe YR ?

If,f Function called at Winlog startup

Function void main()

#3tartup

nformation Y

D ) Mo errors Found

f/**#*ﬁ*ﬁ*****#é***ﬁ***ﬁﬁ**#é**#éﬁ***ﬁ***ﬁ**i
A4 Open default page
ff*f*éffééf*f*éfi*éfif*fff*éfff*fif*éfif*f*fi

TPRageCpen("Main™) ;

end -

1| | »
11 [ |Insert |Zvntax checking. .. i
Code syntax checking
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8. Project execution

Our example is complete.

Wire devices to the serial port; to run the project, in Project Manager select Execute. .. from Project
menu.

Now we are entering in the "run-time" phase that is application execution mode. Winlog Pro samples variables
from devices and processes results in graphical representations (trends and template) and in tabular representations
(reports and historical data).

At project startup, main template will appear automatically.

From Supervision menu you can display graphical trends; select menu item Charts. . . and define the group
of variables that you want to display as graphical trends.

Again in Supervision menu you can display both the online status (Status>Alarms. . .) and the story
(Historical>Alarms...) of all alarms that have been created with Gate Builder.

=10 x|
Fil= Edrk PRecipa Supervision Repatts Maoo Alams  Password Window  Help
0=l
TEST DEVICE H2
| i)
TEMPERATURE | 450°C e [ “q@
SETPOINT E453 Z| -
TEST DEVICE #1 ourru  [IEEE | 10 e
TEMPERATURE | 23T | WAL A @ 30 | 70
SETPOIMT 230 L gn__ __EU
OUTFUT 23 - -
0 | _50
wreRNeLALERM @ Ly i
200 | 40
150 =
100_| 2
50 | 10
o] o
| ! | ! | ' ]
11:24:06 112548 11:27:30 1:25912
19/05/05 18/05/05 13/05/05 1905/05
3 & | Beetidoom| Onine |3 |
& Active Alarms E =10 =|
Sort I Fikes | Ack | Ack al | I~ Exclugad
| Acive | Ack | M [ Dae | Time [ Clast | Clazs 2 [ Tosek [ Exchs.
[ = ——  Altenticed - Irdesrial Alam T est Devicet2 19/05/2005 112239 [1] - - -
| ¥

o
Isﬁiﬁ! e I N . . 8 8 O = =

User: [rane] | 13/05/2005 11.26.47

Allention! - Intemnal Alarm Test Devicell2

Project execution
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